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Notice

Descriptions of circuits, software and other related information in this document are provided only to illustrate the
operation of semiconductor products and application examples. You are fully responsible for the incorporation of
these circuits, software, and information in the design of your equipment. Renesas Electronics assumes no
responsibility for any losses incurred by you or third parties arising from the use of these circuits, software, or
information.

Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas
Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever
for any damages incurred by you resulting from errors in or omissions from the information included herein.

Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual
property rights of third parties by or arising from the use of Renesas Electronics products or technical information
described in this document. No license, express, implied or otherwise, is granted hereby under any patents,
copyrights or other intellectual property rights of Renesas Electronics or others.

You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or
in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from
such alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High
Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality
grade, as indicated below.

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment;
audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and
industrial robots etc.

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster
systems; anticrime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a
direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may
cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the
quality grade of each Renesas Electronics product before using it in a particular application. You may not use any
Renesas Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any
way liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics
product for which the product is not intended by Renesas Electronics.

You should use the Renesas Electronics products described in this document within the range specified by Renesas
Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage
range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no
liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified
ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products
have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use
conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to
implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by
fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software
including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very
difficult, please evaluate the safety of the final products or systems manufactured by you.

Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental
compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all
applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation,
the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your
noncompliance with applicable laws and regulations.

Renesas Electronics products and technology may not be used for or incorporated into any products or systems
whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You
should not use Renesas Electronics products or technology described in this document for any purpose relating to
military applications or use by the military, including but not limited to the development of weapons of mass
destruction. When exporting the Renesas Electronics products or technology described in this document, you should
comply with the applicable export control laws and regulations and follow the procedures required by such laws and
regulations.

It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or
otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set
forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties
as a result of unauthorized use of Renesas Electronics products.

This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of
Renesas Electronics.

Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in
this document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its

majority owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics

(2012.4)




Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 20m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use the e’ studio IDE to develop
and debug software for the RSK platform. It is intended for users designing sample code on the RSK platform,
using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to load and debug a project in e” studio, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX23T microcontroller may be found in the RX23T Group Hardware Manual and within the
provided sample code.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur
within the body of the text, at the end of each section, and in the Usage Notes section.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to
the text of the manual for details.

The following documents apply to the RX23T Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK hardware. RSKRX23T User’s R20UT3318EG
Manual
Tutorial Manual Provides a guide to setting up RSK environment, RSKRX23T Tutorial R20UT3322EG
running sample code and debugging programs. Manual
Code Generator Provides a guide to code generation and importing RSKRX23T Code R20UT3324EG
Tutorial into the e? studio IDE. Generator Tutorial
Manual
Quick Start Guide Provides simple instructions to setup the RSK and RSKRX23T Quick R20UT3323EG
run the first sample, on a single A4 sheet. Start Guide
Schematics Full detail circuit schematics of the RSK. RSKRX23T R20UT3317EG
Schematics
Hardware Manual Provides technical details of the RX23T RX23T Group RO1UH0520EJ
microcontroller. Hardware Manual




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC Analog-to-Digital Converter

API Application Programming Interface

bps Bits per second

CMT Compare Match Timer

COM COMmunications port referring to PC serial port

CPU Central Processing Unit

DVvD Digital Versatile Disc

El Renesas On-chip Debugging Emulator

GUI Graphical User Interface

IDE Integrated Development Environment

IRQ Interrupt Request

LCD Liquid Crystal Display

LED Light Emitting Diode

LSB Least Significant Bit

LVD Low Voltage Detect

MCU Micro-controller Unit

MSB Most Significant Bit

PC Personal Computer

Pmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface_Specification

PLL Phase-locked Loop

RAM Random Access Memory

ROM Read Only Memory

RSK Renesas Starter Kit

RTC Realtime Clock

SAU Serial Array Unit

SCI Serial Communications Interface

SPI Serial Peripheral Interface

TAU Timer Array Unit

TFT Thin Film Transistor

TPU Timer Pulse Unit

UART Universal Asynchronous Receiver/Transmitter

USB Universal Serial Bus

WDT Watchdog timer

All trademarks and registered trademarks are the property of their respective owners.



http://www.digilentinc.com/index.cfm
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RSKRX23T

RENESAS STARTER KIT

R20UT3322EG0100
Rev. 1.00
Aug 24, 2015

1. Overview

1.1  Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to get the RSK
tutorial started, and basic debugging operations.

1.2 Features

This RSK provides an evaluation of the following features:

The RSK board contains all the circuitry required for microcontroller operation.

Renesas microcontroller programming

User code debugging

User circuitry such as switches, LEDs and a potentiometer
Sample application

Sample peripheral device initialization code

R20UT3322EG0100 Rev. 1.00
Aug 24, 2015 RENESAS
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RSKRX23T 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, the most common questions asked about using a Renesas
Starter Kit (RSK). The tutorials help explain the following:

e How do | compile, link, download and run a simple program on the RSK?
e How do | build an embedded application?
e How do | use Renesas’ tools?

Files referred to in this manual are installed using the project generator as you work through the tutorials. The
tutorial examples in this manual assume that installation procedures described in the RSK Quick Start Guide
have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction to
e? studio, the compiler toolchains or the E1 emulator. Please refer to the relevant user manuals for more in-depth
information.

2.1 Code Generator Plug in

The Code Generator plug in for the RX23T has been used to generate the sample code discussed in this
document. Code Generator for e’ studio is a plug in tool for generating template ‘C’ source code and project
settings for the RX23T. When using Code Generator, the engineer is able to configure various MCU features
and operating parameters using intuitive GUI controls, thereby bypassing the need in most cases to refer to
sections of the Hardware Manual.

Once the engineer has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘r_cg_xxx.h’, ‘r_cg_xxx.c’,
and ‘r_cg_xxx_user.c’, where ‘xxx’ is a three letter acronym for the relevant MCU feature, for example ‘adc’.
Within these code modules, the engineer is then free to add custom code to meet their specific requirement.
Custom code should be added, whenever possible, in between the following comment delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Code Generator will locate these comment delimiters, and preserve any custom code inside the delimiters on
subsequent code generation operations. This is useful if, after adding custom code, the engineer needs to re-
visit Code Generator to change any MCU operating parameters.

2.2 Note Regarding Source Code

Due to the project generator, it is possible that line numbers for source code illustrated in this document do not
match exactly with that in the actual source files. It is also possible that the source address of instructions
illustrated in this manual differ from those in user code compiled from the same source. These differences are
minor, and do not affect the functionality of the sample code nor the validity of this manual.

R20UT3322EG0100 Rev. 1.00 ey
Aug 24, 2015 RENESAS




RSKRX23T

3. Tutorial Project Workspace

3. Tutorial Project Workspace

3.1

Introduction

e’ studio is an open source integrated development tool that allows the user to write, compile, program and
debug a software product on many of the Renesas microcontrollers.

3.2

Connecting the Debugger

For this tutorial the E1 debugger will provide power to the RSK, no external power supply is required.

The Quick Start Guide provided with the Renesas Starter Kit board gives detailed instructions on how to
connect the E1 to the host computer. The following assumes that the steps in the Quick Start Guide have
been followed and the E1 drivers have been installed.

Fit the PMOD LCD display to the board. Ensure all the pins of the connector are correctly inserted in the

socket.

Connect the E1 Debugger to a free USB port on your computer.
Connect the E1 Debugger to the target hardware ensuring that it is plugged into the connector marked

‘ET1.
3.3 Starting e? studio and Importing Sample Code
e Start e” studio by selecting it from the [ vonercLais (ol

Windows™ Start Menu. The first dialog box Selectaworkspace

to appear will be the Workspace Launcher. Choose 2 werepmce fode to et s san
e Click ‘Browse’ and select a suitable location Workspace B

to store your workspace, using the ‘Create

New Folder’ option as necessary. Click ‘OK’.

[] Use this as the default and do not ask again
0K l I Cancel

e The e’ studio welcome splash screen will

appear. Click the ‘Go to the workbench’ T IENESAS

arrow button on the far right (circled in the

sereenshot oppostte). Welcome to

e2studio
Uu‘vr\m-w '/__ Renesas T\fu.n.qh
Y V.rrr-\.l \h-Enl O Workl k

R20UT3322EG0100 Rev. 1.00 RENESAS Page 9 of 24

Aug
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RSKRX23T 3. Tutorial Project Workspace

e Once the environment has initialized, right i
click in the ‘Project Explorer’ window and C/Cr+ - e studio
select ‘Import...’ File Edit Source Refactor Mavigate Se
== | 3 - - g |
[ Project Explorer &2 = B
BE&|e ¥
Mew ¥
2y Import..
iy Export..
# Refresh Fa
e The Import dialog box will now show. Expand lo%] Import =8 = <
the ‘General’ folder icon, and select ‘Existing Seloct
ProjeCtS into Workspace” then click ‘Next'. Create new projects from an archive file or directory. | g\J EI
Select an import source:
type filter text
4 (= General &

[T, Archive File
I Existing Projects into Workspace
[, File System
¥ HEW Project
£ Preferences
T Renesas Common Project File
&= C/C++
i+ = Code Generator
p & CVS
& Git
(= IAR Embedded Workbench =
. = Install
(= Run/Debug
2. QUN =

m

R20UT3322EG0100 Rev. 1.00 RENESAS Page 10 of 24
Aug 24, 2015



RSKRX23T 3. Tutorial Project Workspace

e The Import dialog box will allow you to rImpor‘t = |[= =]
specify a project to import. Click the ‘Browse Import Projects p .
bUtton and |Ocate the fOIIOWIng dlreCtory: Select a directory to search for existing Eclipse projects. / ;’

-
C:\Renesas\Workspace\RSK\RSKRX23T © Select root directory:  C:\Renesas\Workspace\RSK\RSKRX23T
() Select archive file: Browse...

e Ensure that the ‘Copy projects into Projects:

Workspace’ Option is tiCked, and then click Application (C:\Renesas\Workspace\RSKRSKRX23 T\ Application Select All
‘Finish’. Async_Serial (Ch\Renesas\Workspace\ RSKARSKRX23T\ Async_Serial

Low_Power_Mode (C\Renesas\Workspace\RSK\RSKRX23T\Low_P Deselect All
System_Input_Capture (C:\Renesas\ Workspace\RSK\RSKRX23T Sy
Timer_PWM (C:\Renesas\Workspace\RSK\RSKRX23 T\ Timer_PWM

Tutorial (C:\Renesas\Workspace\RSK\RSKRX23T\ Tutorial)

4 I 3

Options

[] Search for nested projects

Copy projects into workspace

[] Hide projects that already exist in the workspace

Working sets

[] Add project to working sets

Select...
@ Next > Finsh | [ Cancel
e Click on Tutorial from the list of projects in - 25 Systern_Input_Capture
the ‘Project Explorer’ on the left-hand side. . 25 Timer Py
- 125 Tutorial

3.4 Build Configurations and Debug Sessions

34.1 Build Configuration

The e” studio workspace will be created with two build configurations: ‘HardwareDebug’ and ‘Release’.

Release
This build mode has optimisation turned on, and provides little debug information. The C code execution may

appear to be out of order, due to the way compiler optimises the code. This build configuration is intended for
final ROM-programmable code.

HardwareDebug

This build mode has all optimisation turned off, and provides full debug information. This is the best
configuration to use whilst developing code as C code execution will be linear.

e Click the top level ‘Tutorial’ folder again, and R~ il W0
then the arrow next to the build button - ' : : : :
(hammer icon), and select the % v 1 HardwareDebug (Debug on hardware)

‘HardwareDebug’ option. 2 Release (Release - Me Debug)

e € studio will now build the code.

R20UT3322EG0100 Rev. 1.00 RENESAS Page 11 of 24
Aug 24, 2015



RSKRX23T

3. Tutorial Project Workspace

3.4.2 Debug Configuration

e Click the arrow next to the debug button (bug

icon). Select ‘Debug

Configurations’.

e The '‘Debug Configurations’ dialog box will
appear. Click the small arrow next to the
‘Renesas GDB Hardware Debugging’ option.

e The debug configurations for each project will
appear. Select the entry for the ‘Tutorial
Hardware Debug’.

e The debug configurations control page will
then show for the Tutorial project. Change the
main tab to ‘Debugger’ and then select
‘Connection Settings’ on the secondary tab bar
that appears.

e There is no need to change the debugger
settings as they are preconfigured with the
Tutorial project.

e Refer to the RSKRX23T User’s Manual for
details of power supply configuration.

Note: e? studio will display a warning if
you attempt to connect with an incorrect
power supply setting.

$-0-Q-NSE 5

(na launch history)

Debug As L
Debug Configurations...

Organize Favorites...

pe

Debug Configurations

Create. manage. and run configurations

| B3~ Configure launch settings frc
type filter text - Press the 'MNew' button
C/C++ Application |'=| - Press the 'Duplicate’ by

[E] C/C++ Attach to Application
C/C++ Postrmortern Debugger
Custom Debug o - Press the 'Filter' buttor
Debug-only
GDEB Hardware Debugging
it GHS Local C/C++ Launch
HEW Debugging
&% Renesas GDB Hardware Attach
I @ Renesas GOB Hardware Debuggir
Renesas GDB Simulator Debuggir

¥ - Press the 'Delete’ buttc

- Edit or wiew an existing

Configure launch perspectivi

]

2 Main 1;5 Debugger B Startup B Source| ] Common

Debug hardware: Target Device: | RSF523T5
GDB Settings | Connection Settings | Debug Tool Settings

[

a4 Cock
Main Clock Source EXTAL
Extal Frequency[MHz] 20.0000
Permit Clock Source Change On Writing Internal F Yes

4 Connection with Target Board

Emulator (Auto)
Connection Type Fine
ITag Clock Frequency[MHz] 16.5
Fine Baud Rate[Mbps] 2.00
Hot Plug No
4 Power

Power Target From The Emulator (MAX 200mA)  Yes
Supply Veltage 33v

4 CPU Operating Mode

Register Setting Single Chip

Made pin Single-chip mode
e Click the ‘Debug’ button to continue. e’ studio
will now connect to the debugger and
download the code to the target.
R20UT3322EG0100 Rev. 1.00 REN ESAS Page 12 of 24
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RSKRX23T 3. Tutorial Project Workspace

o Afirewall warning may be displayed for ‘e2- )
server-gdb.exe’. Check the ‘Private networks, S —
such as my home or work network’ box and
click ‘Allow access’.

@ Windows Firewall has blocked some features of this program

windows Firewall has blocked some features of E2 Server GDB on all public and private

e Auser account control dialog may be reorks e v
displayed. Enter the administrator password W e e sronts
and C||Ck lYeS! Path: C:\renesas\e2_studio'\debugcomp\e2-servergdb.exe

Allow E2 Server GDB to communicate on these networks:
Private networks, such as my home or work network

[T BUbiic nefiworis, sudh 3s Those in airpor s and coffes shaps (ot recommended
because these networks often have it o no security)

What are the risks of allowing a program through a firewall?

e After downloading the code a dialog box will

appear asking if you would like to switch to the [lefl Confirm Perspective Switch ==
‘Debug perSpeCtive'. C“Ck ‘Remem ber my '9‘ This kind of launch is configured to open the Debug perspective when it suspends,
deCISlon, to prevent thls dlalog bOX from - This Debug perspective is designed to support application debugging. It
appearing in future, then click ‘Yes’ incorporates views for displaying the debug stack, variables and breakpoint
' management.
° 82 StUdIO Wl“ |0ad the new perSpeCtlve, WhICh Do you want to open this perspective now?

is optimised for debugging.

|| Remember my decision

e To change back to the default ‘C/C++’
perspective, from the menu bar select Window
> Open Perspective > Other.

e The ‘Open Perspective’ dialog box will appear.
Click on the desired perspective to select it | Code Generator
then ‘OK’. CVS Repository Explering
#C?Debug
|r| Git Repasitory Exploring

Open Perspective | o [(& ]3]

') Planning
(o Resource
B SVN Repository Exploring
Q:'Team Synchronizing

e Alternatively, click on the button with the 3
double arrow in the top right corner of the [ (3 Debug
screen, as shown opposite, and select the
BE C/Ces

‘C/C++’ option that appears.

3.5 Running the Tutorial

e Refer to the description.txt file for instructions on how to configure the RSK and run the sample code.

e Once the code has been downloaded, click ‘Resume’ to run the code to the main function. The main
function is set as the program entry point by default. The program counter will stop on the first instruction
in the main function.

e Click the ‘Resume’ button in the ‘Debug’ perspective to run the rest of the code
e Itis recommended that you run the entire tutorial demo first, before continuing to debug it.

R20UT3322EG0100 Rev. 1.00 RENESAS Page 13 of 24
Aug 24, 2015



RSKRX23T

4. Reviewing the Tutorial Program

4. Reviewing the Tutorial Program

This section will look at each section of the tutorial code and basic debugging functionality in e’ studio.

4.1

Program Initialization

Before the main program can run, the microcontroller must be configured. The following parts of the tutorial
program are used exclusively for initializing the RSK device so that the main function can execute correctly.
The initialization code is run every time the device is reset via the reset switch or from a power cycle.

Build and download the code as shown in
Section 3.3.

On the Project Explorer tab expand the
‘Tutorial’ folder by clicking on the arrow
next to the folder icon, as highlighted by the
red circle.

Click the arrow next to the ‘src’ folder to
show the source files.

Expand the ‘cg_src’ folder in the same way
and double click on
‘r_cg_hardware_setup.c’ to open the file.

Breakpoints can be set by double clicking
at the left-hand edge of the source window.
On the line with instruction R_Systeminit(),
double click next to the vertical line to set a
breakpoint.

Note: As an alternative breakpoints may be set
in the C/C++ perspective by selecting a line
and using Run > Toggle Breakpoint.

Click the ‘Resume’ button in the Debug
perspective (or press [F8]) to run the code
up to this breakpoint.

L=

Note: The program counter is indicated by the
blue arrow next to the breakpoint.

5= Qutline | [ Project Explorer 52

+ 1% Systern_Input_Capture
. == Timer_PWM

Oﬁ Tuterial [HardwareDebug]

4 == Tutorial [HardwareDebug]
s f_f' Binaries
+ [t Includes
4 B src
4 (= cg_src

- €| r_cg_cge_user.c
+ L] reg_cge.c
- r_cg_cgc.h
- |lg|] r_cg_cmt_user.c
- g r_cg_cmt.c
s r_cg_crnt.h
- L) r_cg_dbsct.c
| e r_cg_hardware_setup.c
- |lg| r_cg_icu_user.c

void HardwareSetup(void)

{

4 ffcpde79 R_Systeminit();
i

void HardwareSetup(void)

1

ffceee7a R_Systeminit();

¥

=
b ka

21

I s B R o R %

Vo B

R20UT3322EG0100 Rev. 1.00

Aug 24, 2015
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RSKRX23T 4. Reviewing the Tutorial Program

e Click the ‘Step Into’ button (or press [F5]),
to step into the ‘R_Systeminit’ function.

ERERERE

* Function Name: R_:

[LRTLET

<o

* Description : This function initializes every macro.
58 * Arguments ¢ None
—_ 59 * Return Value : None
_._“? P DR N —_
== fffeaffc - void R_Systeminit(void)
{
‘ init! H * Enable writing to registers related to operating moc
* The R—SyStemlnlt funCtlon Ca”sseveral fffeleel SYSTEM.PRCR.WORD = @xA56BU;
initialization functions which configure the
i ici * Enable writing to MPC pin function control registers
MCU for normal operation. This includes —— .. R, T, AT, = D
input/output ports, and system clocks. fffelo11 MPC.PWPR.BIT.PFSHE = 1U;
e The user can step through all the s /* Set peripheral settings */
initialization code by clicking the ‘Step Into’ e e
icon and reading the code however for the fffelalb R_PORT Create();
. . . . fffel01f R_CMT@_Create();
purpose of this manual, it will be skipped. fffe1023 R_CMTL Create():
. . s fffe1027 R_CMT2 Create();
e Click the ‘Resume’ button, to run the code Ffe102b R_scn_c:::t:(;;
Up to the main funCtiOI’l. fffel@2f R_SCI5_Create();
fffe1e33 R_S12AD Create();
= /* Disable writing to MPC pin function control register
Ub- fffe103c MPC.PWPR.BIT.PFSWE = U3
fffelo43 MPC.PWPR.BIT.BOWI = 1U;
/* Enable protection */
fffeleda SYSTEM.PRCR.KORD = @xAS@8U;
¥

For further details regarding hardware configuration, please refer to the RSKRX23T User’s Manual and the
RX23T Group Hardware Manual.
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RSKRX23T 4. Reviewing the Tutorial Program

4.2 Main Functions

This section will look at the program code called from with the main() function, and how it works. It is
necessary to connect the RSK G1CUSBO to a PC USB port and open a terminal emulation program, such as
HyperTerminal, with the settings 19200, 8, N, 1. For information on installation of the RSK virtual COM port
driver, refer to the file ‘description.txt’ in the e” studio Tutorial project.

1 fffelldb void main(void)

e Right click the ‘R_SCI1_Serial_Receive()’
function call and select ‘Run to Line’ to
execute the program up to this line. The

{
3 fffellad R MAIN UserIn].t(),

Start user code. Do not edit comment generated here

‘R_LCD_Init()’ function call enables and - R_Sﬁmﬂ_ht()’ e
configures the LCD panel, and : W i Sonci: it S m G sl
‘R_LCD_DISplay()' W|” Write “RSKRX23T ¢ fffel154 R SWITCH SetP;;ssCallback(ch switch p;ess)i ) o
Tutorial Press Any Switch” onto the LCD. . Initialize the debug LCD
3 fffellSe R_LCD_Init();
5 * Displays the application name on the debug LCD */
6 fffellez R_LCD Display(@, (uint8 t *)" RSKRX23T ");
fffellée R_LCD_Display(1, (uint3_t *)" Tutorial ");
g fffell7a R_LCD_Display(2, (uint8_t *)" Press Any Switch ");
> Start the A/D converte
1 fffell86 R_S12AD_Start();
3 * Set up SCI1 receive buffer and callback function *
1 fffellsc R_SCI1 Serial Receive((uint8_t *)&g _rx char, 1);
Enable SCI1 o
7 fffell9s R_SCI1_Start();
H . ’ Set up SCI1 receive buffer and callback function */
® Set a breaprInt on the R_SCIJ-_Start() fffellsc R SCI1 Ser1al _Receive((uint8_t ‘)&g_r‘x char, 1);
function call by double-clicking in the P -
. Enable 5(CT1 operations *
breakpoint column. fffe1196 R_SCI1 Start();
e Click the ‘Step Into’ button to step into the
‘R_SCI1_Serial_Receive ()’ function. .
o
. The program Countel’ Sh0u|d now move |nt0 53 fffeld3s MD_STATUS R_SCI1_Serial_Receive(uint8_t * const rx_buf, uintl6_t rx_num)
the R_SCI1_Serial _Receive function fffe1sse i
definition. This function is an API function frfernse f 7. i)
provided by the Code Generator. It sets up fffels43 g T AR
the UART interrupt handler code to receive s
a specified number of bytes into a receive 163 FFfe1a4s g_scil rx_count = 6U;
. 164 FFfi i1_rx_length = r 3
buffer. Once the specified number of bytes o terci ol rhmirre et
has been received, the interrupt handler bl Foeq ooy e o
code calls a callback function as shown ¥
; i i FFF retur 3
later on in this section. S ey | e
e For full details on how to configure a project
using Code Generator refer to the Code
Generator Tutorial Manual.
e Click the ‘Resume’ button to resume
program execution.
R20UT3322EG0100 Rev. 1.00 RENESANS Page 16 of 24
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4. Reviewing the Tutorial Program

e The program counter should come to a halt

* Set up SCI1 receive buffer and callback function ¥,

fffellsc ﬁ_SCIl_Serial_Receive((uintS_t *)&g_rx_char, 1);
at the R_SCI1_Start function. e ,
* Enable CI1l operations
e Step over the function by click o, fffe1196 R_SCI1 start();
ing the ‘Step Over’ button. Alt ="
ernatively, press [F6].
The R_SCI1_Start() function enables the UART
interrupts. The program then proceeds to the
main while() loop. The code inside the loop wai
ts for user input from either the UART or RSK s
witches, and then performs an A/D conversion.
e Locate the function call to ‘lcd_display_adc - while (10)
()’ inside the while |00p- /* Variable to store the A/D conversion cou
e Set a breakpoint on the ‘lcd_display_adc()’ static uints_t adc_count = ©;
function call by double-clicking in the break uint16_t adc_result;
point column. /* Wait for user requested A/D conversien f
5 ffceefse = if (TRUE == g_adc_trigger)
/* Call the function to perform an A/D
1 ffceefal adc_result = get_adc();
/* Display the result on the LCD */
4 ffceefas lcdjisplay_adc(adc_result),‘
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RSKRX23T 4. Reviewing the Tutorial Program

e Inthe Project Explorer pane, locate the file 4 2= Tutorial [HardwareDebug]
‘r_cg_sci_user.c’ and double-click to open y f;' Binaries
the source file. Scroll down to the function + ) Includes
r_scil callback_receiveend().
PREE(

4 =% Cg_src
- g r_cg_cge_user.c
+ €] reg_cgec
> [h] r_cg_cgeh
« €] r_cg_cmt_user.c
> @ r_cg_cmt.c
> |n] rcg_cmth
o [€ r_cg_dbsct.c
« €] r_cg_hardware_setup.c
> @ r_Cg_icu_User.c
» g rocglicuc
s R r_eg_icuh
« €] r_eg_intprg.c
- [h] r_cg_macrodriver.h
» g r_cg_main.c
i @ r_cg_port_user.c
« €] reg_port.c
- |h] r_cg_port.h
i E| r_cg_resetprg.c
s @ r_cg_sl2ad_user.c
s g reg_sl2ad.c
- [h] r_cg_sl2ad.h
» g rcg_sbrk.c
- [m] r_cg_shrk.h
s | [€] r_cq_sei_user.c

static void r_scil_callback_receiveend(void)

e Set a breakpoint on the line of code inside

. . . {
the r_SCIl_CalIbaCk_rece|Veend func“on as /* Start user code. Do not edit comment generated here *;
ShOWn oppOSite' * Check the contents of g rx_char */
if (('c' == g_rx_char) || ('C' == g_rx_char))

e Continue to execute the program by

clicking the ‘Resume’ button. | g sdc_trigger - TRUE;

/* Set up SCIS receive buffer and callback function again
R_SCI1 Serial Receive((uint3_t *)&g rx_char, 1);

/* End user code. Do not edit comment generated here */
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4. Reviewing the Tutorial Program

e In the terminal emulation window, press the 15

‘c’ button on the keyboard.

e The program will halt at the breakpoint in
the r_scil_callback_receiveend function as b
shown opposite. Remove the breakpoint by
double-clicking on the breakpoint column.

e Continue to execute the program by
clicking the ‘Resume’ button.

e The program will halt at the breakpoint in

the main while loop.

e Remove the breakpoint by double-clicking

on the breakpoint column. Continue to
execute the program by clicking the
‘Resume’ button.

? fffelacd

4 fffelad3

P =

D10

s “ y

n

ffeceatas

ffcoatas

ffceefbe

or
o

| ¢

g_adc_trigger = TRUE;

k the contents of
== g rx_char) |

/* Display the result on the LCD *;
lcd_display adc(adc_result);

/* Increment the adc_count and disp
if (16 == (++adc_count)})

adc_count = @;

led_display_count({adc_count);

The program proceeds to display the result of the A/D conversion on the LCD and in the terminal window. In
addition, the running count of A/D conversions performed is displayed in binary form using LEDs 0-3 on the
RSK. Adjust the potentiometer and press SW1, SW2 or SW3 on the RSK and an additional A/D conversion

will be performed.

e Press the ‘Suspend’ button to halt
program execution.

e To change back to the default ‘C/C++’
perspective, from the menu bar select
Window > Open Perspective > ‘C/C++’

e Alternatively, click on the ‘C/C++’ button
in the top right corner of the screen, as
shown opposite.

e This is the extent of the tutorial code.

| | . |

U

= |

g C/C++

%5 Debug

For further details regarding hardware configuration, please refer to the RX Series Software Manual and the RX23T Group

Hardware Manual.

The E1 emulator features advanced logic-based event point trigger system, and full instruction on its use is outside the
scope of this tutorial. For further details, please refer to the E1 Emulator User's Manual
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RSKRX23T 5. Additional Information

5. Additional Information

Technical Support

For details on how to use e” studio, refer to
the help file by opening e’ studio, then
selecting Help > Help Contents from the  “indow | Help

menu bar. 5 G'@ Yielcorme

c

{7} Help Contents
B Search
Dyharmic Help

Parts of the sample code provided with the RSKRX23T can be reproduced using the Code Generator tool.
Code Generator is included as a plug in with e’ studio.

Source files and functions generated by Code Generator are prefixed with ‘r_"and ‘R_’, respectively.

For information about the RX23T Group microcontrollers refer to the RX23T Group Hardware Manual.

For information about the RX assembly language, refer to the RX Family Software Manual.

Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”

General information on Renesas Microcontrollers can be found on the Renesas website at:
http://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe Limited.

© 2015 Renesas Electronics Europe Limited. All rights reserved.
© 2015 Renesas Electronics Corporation. All rights reserved.
© 2015 Renesas System Design Co., Ltd. All rights reserved.
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